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Overview 

System requirements
– Local Installation

• Administrative access on local machine
• IE version 5.x
• Netscape version 5.x
• IIS version 5.0 or greater is recommended
• Internet connection (Used for some areas)

– Web base use
• IE version 5.x
• Netscape version 5.x
• Internet connection
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Installation 

Local Install
– IIS installation and configuration
– Client Installation and configuration

Web Version
– No installation required
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Local Installation

Install the IIS Server
Install the Client application
Configuring Internet ExplorerConfiguring Internet Explorer
–– Open Internet Explorer.Open Internet Explorer.
–– Click Click Tools > Internet Options...Tools > Internet Options... and then click the and then click the SecuritySecurity tab.tab.
–– Click the Custom Level... button and verify that Click the Custom Level... button and verify that Initialize and script Initialize and script 

ActiveX controls not marked as safeActiveX controls not marked as safe is set to is set to PromptPrompt and click and click OKOK. . 
This setting allows you to save the solutions you create in the This setting allows you to save the solutions you create in the tool.tool.

–– If you're system uses a proxy server complete the following stepIf you're system uses a proxy server complete the following steps:s:
•• Click the Click the ConnectionsConnections tab in the Internet Options window.tab in the Internet Options window.
•• Click the Click the LAN Settings...LAN Settings... button and check the button and check the Bypass proxy Bypass proxy 

server for local addressesserver for local addresses checkbox.checkbox.
•• Click Click OKOK to close the to close the LAN SettingsLAN Settings dialog.dialog.
•• Click Click OKOK to close the Internet Options window.to close the Internet Options window.

–– Reboot your system if you loaded Internet Information Services. Reboot your system if you loaded Internet Information Services. If you If you 
did not have to load Internet Information Services, you are not did not have to load Internet Information Services, you are not 
required to reboot. required to reboot. 
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Local Installation

Operating Systems
– Windows 2000

• If you are running on Windows 2000 the installation process is 
complete. You can access the Backup Sizing Tool by:

• Double-click on the HP StorageWorks Backup Sizing Tool icon 
on your Desktop or in your Start Menu.

• If you are going to run the application from the web, Open Internet 
Explorer and enter: http://localhost/sb/SWBST/index.asp as the 
URL

– Windows XP
• If you are running Windows XP you need to configure Distributed 

COM permissions for the Interactive user. After completing the 
steps in the previous section, complete the following steps:

http://localhost/sb/SWBST/index.asp
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Local Installation

Operating Systems
– Windows XP

• If you are running Windows XP you need to configure Distributed 
COM permissions for the Interactive user. After completing the 
steps in the previous section, complete the following steps:

• Click Start > Run, and enter Dcomcnfg in the Run dialog to launch 
DCOMCNFG.

• In the Component Services window, double-click on Component 
Services under Console Root.

• Double-click Computers under the Component Services.
• Right-click My Computer under Computers and click Properties

on the menu that displays. 
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Local Installation
Operating Systems
– Windows XP (Continued)

• Note: The following steps will need to be repeated for both Access 
Permission and Launch Permission.

• Click the Default COM Security tab and then click Edit Default
button in the Access Permissions frame. The Access Permission
dialog is displayed.

• Add the IUSR_ account:
(a) Click the ADD button.
(b) Click the Advanced button. This will open the Select 
Users or Groups dialog.
(c) Click the Location button and select the local computer 
name.
(d) Click OK and then click the Find Now button. A list of 
users and groups will be displayed.
(e) Highlight the entry which starts with IUSR and click OK to 
add it to the Select Users or Groups dialog. 
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Local Installation 

Operating Systems
– Windows XP (Continued)

• Repeat the same instructions in the add IUSR_Account Secion to 
add the INTERACTIVE account.

• Click OK to close the Select Users or Groups dialog.
• Click OK to close the Access Permission dialog.
• Click the Default COM Security tab and then click Edit Default

button in the Access Permissions frame. The Access Permission
dialog is displayed.

• Note: Repeat steps listed above to complete the Distributed COM 
permissions for the Interactive user

• Click OK to close the My Computer dialog.
• Select File > Exit to close the Component Services window.
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Local Installation 

Operating Systems
– Windows XP (Continued)

• Open Windows Explorer:
• Right-click the drive letter of the local drive where you will be 

storing solutions.
• Select Properties
• Click the Security tab and verify that the IUSR and INTERACTIVE 

users have access to READ, WRITE and MODIFY files on the 
drive

• If these 2 users are not displayed, click the ADD button to view 
users for the local compute

• Add IUSR and INTERACTIVE users by clicking those user names 
and clicking the ADD button.

• Click OK. Check READ, WRITE and MODIFY options for the IUSR 
and INTERACTIVE accounts and click OK. This step allows 
StorageWorks Backup Sizing Tool users on the local machine to 
save solutions on this local drive.
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Local Installation

Operating Systems
– Windows XP (Continued)

• In Windows Explorer:
• Navigate to the location where Sizer is installed. By default, this is 

located at [OS Drive]:\inetpub\wwwroot\SB, where [OS Drive] is 
the drive letter of the local drive.

• Right-click the SB folder and select Properties.
• Click the Security tab and verify that the Everyone user is set up 

with full control.
• From the \SB folder, navigate to \SWBST\Dlls ([OS 

Drive]:\inetpub\wwwroot\SB\SWBST\Dlls if you installed to the 
default location). Double-click the Register.bat file to update 
SWBST components information. 
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GUI Interface 

In the next slides we will look at In the next slides we will look at 
specific screens within the tool which specific screens within the tool which 
are used in configuration control to are used in configuration control to 
determine the correct solution.determine the correct solution.
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Major areas and uses

Initial Startup Screen

The End User The End User 
License License 

Agreement Agreement 
(EULA)(EULA)
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Major areas and uses

1.  Build a Solution1.  Build a Solution

2.  Organize a Solution2.  Organize a Solution

3.  Product 3.  Product 
InformationInformation

4.  Download offline 4.  Download offline 
VersionVersion

Divided into 4 Divided into 4 
major Sections

Online VersionOnline Version
major Sections
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Major areas and uses

1.  Build a Solution1.  Build a Solution

2.  Organize a Solution2.  Organize a Solution

3.  Product Information3.  Product Information

4.  4.  SizerSizer Tool UpdatesTool Updates

Divided into 4 Divided into 4 
major Sections

Downloadable VersionDownloadable Version
major Sections
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Major areas and uses

Choose the type of Choose the type of 
Backup Solution you Backup Solution you 

wish to buildwish to build

1.  1.  FibreFibre Channel SolutionChannel Solution

2.  Direct Attached Backup2.  Direct Attached Backup

With either of these solutions, With either of these solutions, 
you may choose the data you may choose the data 
protection software you wish protection software you wish 
to use, or remain undecided.  to use, or remain undecided.  
This can be changed later.This can be changed later.
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Major areas and uses

Define the number of Define the number of 
servers and the servers and the 
different different 
configurations. Click configurations. Click 
on the “add” button on the “add” button 
to begin configuring to begin configuring 
your first server.   your first server.   

Additional servers may be added Additional servers may be added 
after the first server is configured.  after the first server is configured.  
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Major areas and uses

Define:Define:

1.1. Server NameServer Name
2.2. Model or TypeModel or Type
3.3. Operating SystemOperating System
4.4. Type of Host Bus AdapterType of Host Bus Adapter
5.5. Cluster supportCluster support

Each server can and Each server can and 
should be configured should be configured 
with its own unique with its own unique 

attributes.  attributes.  
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Major areas and uses

Each Server contains 1 Each Server contains 1 
or more volumes of data.  or more volumes of data.  
It is important to It is important to 
configure each volume’s:configure each volume’s:

1.1. SizeSize
2.2. Estimated annual growthEstimated annual growth
3.3. Estimated Compressibility of Estimated Compressibility of 

the Data on the volumethe Data on the volume
4.4. Volume interconnectVolume interconnect
5.5. Backup Strategy to be usedBackup Strategy to be used
6.6. Number of Backup sets to Number of Backup sets to 

be maintainedbe maintained
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Major areas and uses

Scheduling information Scheduling information 
is determined on a per is determined on a per 
volume basis.  volume basis.  

Backup duration determines Backup duration determines 
the amount of time allotted for the amount of time allotted for 
a given backup to run and is a given backup to run and is 
used in determining the overall used in determining the overall 
proper solution.proper solution.

Days of the week and type of Days of the week and type of 
backup desired are selected via backup desired are selected via 
the checkboxes and the checkboxes and pulldownspulldowns..
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Major areas and uses

Once a volume has Once a volume has 
been configured, you been configured, you 
can then either add, can then either add, 
delete or copy delete or copy 
(clone) this volume (clone) this volume 
to add additional to add additional 
volumes to the volumes to the 
server.  This process server.  This process 
is repeated until all is repeated until all 
volumes are added volumes are added 
to the server.to the server.
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Major areas and uses

Once a server has been Once a server has been 
configured, you can then configured, you can then 
either add, delete or copy either add, delete or copy 
(clone) this server to add (clone) this server to add 
additional servers to the additional servers to the 
solution.  It’s important solution.  It’s important 
to get as much to get as much 
information on each information on each 
server, and add all server, and add all 
servers that will be servers that will be 
included in the solution.  included in the solution.  
This will allow the tool to This will allow the tool to 
properly size the solution.properly size the solution.
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Major areas and uses

The final step in the The final step in the 
basic configuration basic configuration 
is to choose the is to choose the 
type of interconnect type of interconnect 
device (switch) that device (switch) that 
you will be using.  you will be using.  
Devices that are Devices that are 
shown are shown are 
supported within supported within 
the solution.the solution.

Note:  This screen does not show Note:  This screen does not show 
up in the DAS solution matrixup in the DAS solution matrix
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Major areas and uses

This screen has This screen has 3 3 
options:options:

•• SaveSave
•• Save configuration for Save configuration for 

reviewreview
•• CustomizeCustomize

•• Change the Change the 
configuration or tape configuration or tape 
solutionsolution

•• View SolutionView Solution
•• View your configurationView your configuration

You can configure a solution You can configure a solution 
from scratch using this linkfrom scratch using this link

Choices ScreenChoices Screen
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Major areas and uses

The customize screen gives The customize screen gives 
you several options.  From you several options.  From 
here, you can change the here, you can change the 
type of tape drive you type of tape drive you 
want, change the type of want, change the type of 
tape library, or you can tape library, or you can 
modify the configuration of modify the configuration of 
the existing library.  the existing library.  
Additionally, a host of Additionally, a host of 
options on the left give you options on the left give you 
the ability to modify your the ability to modify your 
solution or view schedule, solution or view schedule, 
summary, etcsummary, etc
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Major areas and uses

The schedule view The schedule view 
allows you to examine allows you to examine 
each configured each configured 
volume within the volume within the 
solution and see the solution and see the 
day, start time, and day, start time, and 
duration of each duration of each 
backup which is backup which is 
associated with the associated with the 
solution you have solution you have 
chosenchosen
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Major areas and uses

The audit view is a new The audit view is a new 
screen which was added to screen which was added to 
account for customers account for customers 
annual growth potential.  It annual growth potential.  It 
will give you % of usage of will give you % of usage of 
the given solution, as well the given solution, as well 
as allow you to change the as allow you to change the 
annual growth rate to help annual growth rate to help 
you determine how long it you determine how long it 
will take to outgrow this will take to outgrow this 
solution.solution.
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Major areas and uses

The summary view The summary view 
details the entire details the entire 
solution with all solution with all 
volumes, part volumes, part 
numbers, and numbers, and 
information about each information about each 
configured server and configured server and 
their volumes.  Part their volumes.  Part 
number information is number information is 
also contained in the also contained in the 
table, along with table, along with 
required quantities.required quantities.
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Major areas and uses

After filling out the After filling out the 
required information required information 
about yourself and your about yourself and your 
customer, the tool will customer, the tool will 
allow you to open or allow you to open or 
save the proposal.save the proposal.

*Note, you must have MS *Note, you must have MS 
Word loaded for this to Word loaded for this to 
function. Immediately after function. Immediately after 
opening the proposal opening the proposal 
generator, SAVE YOUR generator, SAVE YOUR 
WORK FIRSTWORK FIRST
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The Proposal 
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The Proposal 
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The Proposal 
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The Proposal 
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The Proposal 
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The Proposal 
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QuestionsQuestions
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LAB 

Lab #1 – Direct attach Scenario
Lab #2 – F/C Scenario
Lab #3 – F/C Scenario
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LAB #1

Direct AttachDirect Attach
A customer wants to do a backup of one of his HP Proliant 
server running Data Protector and Windows 2000 Advanced 
Server.  The server has 1 volume.  Volume 1 is on the internal 
5I controller and has 85GB of 2 to 1 compressible data, and is 
showing a global annual growth of 25%. They want to have 1 
full set of backups on hand at all times,and want the full 
backups to occur on Mondays, Wednesdays, and Fridays. 
Select the best solution for this customer.



HP World 2003  Solutions and Technology Conference & Expo page 4011/17/2003

LAB #1
What backup device is the best What backup device is the best 
choice for this customer?choice for this customer?

What is the duration of the longest backup job that will run on What is the duration of the longest backup job that will run on thisthis
server?  server?  

How many tapes will be required?  How many tapes will be required?  

What is the part number for the What is the part number for the UltriumUltrium 460 internal tape drive?  460 internal tape drive?  

If the “Good” solution were chosen If the “Good” solution were chosen 
how long would each backup take? how long would each backup take? 

What is the Part number of the SDLT 220 Internal Drive?  What is the Part number of the SDLT 220 Internal Drive?  

UltriumUltrium 460 Internal Tape Drive460 Internal Tape Drive

30 Minutes30 Minutes

22

Q1518AQ1518A

1 hour 35 min1 hour 35 min

192106192106--B25B25
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LAB #2
FibreFibre AttachAttach

A customer wants to do a backup of 3 of his HP Proliant servers 
running Veritas Netbackup and Windows 2000 Advanced Server.  
Two of the servers are identical. They use an HP Storageworks
A7298A HBA’s.  1 Volume is 500GB of 2:1 compressible data with a 
20% annual growth connected to an MSA1000 Array controller.  The
second volume is 200GB of 1:1 compressible data with a 10% annual 
growth connected to an HSV Controller (EVA).   They want to 
maintain 3 backup sets of all data on hand and do full backups on 
Sunday with Incremental backups on Mon-Fri.  The other server is a 
Proliant server with a 64 bit PCI to Fibre Channel HBA running 
Windows NT.   Volume 1 is 500GB of 2:1 compressible data with a 
5% annual growth rate connected to an HSG80 Controller.  They 
want to maintain 3 backup sets of all data on hand and do full 
backups on Sunday with Differential backups on Mon-Fri.  All 
components are interconnected via a 16 Port Switch.   Choose the
better solution.
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LAB #2

What backup device is the better What backup device is the better 
choice for this customer?choice for this customer?

What is the duration of Server 1’s volume 2 incrementalWhat is the duration of Server 1’s volume 2 incremental
Backup take each day?Backup take each day?

How many tapes will be required?  How many tapes will be required?  

If the customers annual growth changed to 65%, how long would beIf the customers annual growth changed to 65%, how long would be required required 
before their user defined tapes would be exhausted?  before their user defined tapes would be exhausted?  

If the “Best” solution were chosen how long would Server 1’s volIf the “Best” solution were chosen how long would Server 1’s volume 2 ume 2 
incremental Backup take each day? incremental Backup take each day? 

What is the Part number for an ESL9595L1?  What is the Part number for an ESL9595L1?  

ESL9322L1ESL9322L1

52 Minutes52 Minutes

112112

5 Years5 Years

52 Minutes52 Minutes

176479176479--B21B21
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LAB #3
FibreFibre AttachAttach

A customer operates a server farm of 8 servers.  Customer wants to use CA
Brightstor Enterprise Backup. Half of the servers are HP Proliant W2K 
Advanced Servers, 2 servers are Sun Solaris 8.0 servers, and 2 are HP 
Netservers running W2K Advanced Server.  All Servers in each family type 
are configured identically from a volume perspective.  All HP Servers are 
using the HP Storageworks A7298A HBA’s.  All Sun Servers are using the 
Storageworks F/C HBA for Solaris (254456-B21).  All W2K Servers contain 1 
volume of 370GB of 1.5:1 compressible data with a 25% annual growth 
connected to an MSA1000 Array controller.  All Sun Solaris 8.0 have 1 
volume which is 200GB of 1:1 compressible data with a 10% annual growth 
connected to an array controller (XP).  The HP Netservers have 1 volume of 
200GB of 1.7:1 compressible data with a 5% annual growth and a medium 
feed speed.

They want to maintain 3 backup sets of all data on hand and do full backups 
on Sunday with Differential backups on Mon-Fri.  All components are 
interconnected via a 32 Port Switch.   Choose the better solution.
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LAB #3

What backup device is the betterWhat backup device is the better
choice for this customer? ESL9595S2choice for this customer?

What is the duration of the longest backup job that will run on What is the duration of the longest backup job that will run on thisthis
Schedule?  Schedule?  

How many tapes will be required?  How many tapes will be required?  

How many upgrade drives will be required?  How many upgrade drives will be required?  

What is the Part number of the SDLT 160/320 Drive?  293414

ESL9595S2

9 Hours 9 minutes9 Hours 9 minutes

168168

44

What is the Part number of the SDLT 160/320 Drive?  293414--B21B21
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